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Managing your server, adapters, and devices

Learn about managing servers, adapters, and devices using a console.

Use the following information to assist you in managing your server, adapters, and devices, using a hardware
platform console or interface:

Managing your server using the Hardware Management Console
Learn how to manage your server using the Hardware Management Console.

• 

Managing your server using the ASMI
The Advanced System Management Interface (ASMI) is the interface to the service processor that
allows you to set flags that affect the operation of the server, such as auto power restart, and to view
information about the server, such as the error log and vital product data.

• 

Managing devices
This topic describes the specifications and maintenance of adapters and devices.

• 

Managing your server using the Hardware Management Console

Learn how to manage your server using the Hardware Management Console.

The Hardware Management Console (HMC) uses its network connections to one or more servers or frames
(referred to as managed systems) to perform various management functions. This topic provides information
about how to perform tasks with the HMC to manage the connected systems.

For information about how to perform basic HMC administration tasks, including setting up, installing, and
maintaining an HMC, see the Managing the Hardware Management Console (HMC) topic.

For information about partitioning your server using an HMC, see the Partitioning with an HMC topic.

What's new
Learn about new and improved information in Managing your server using the HMC.

• 

Printable PDFs
If you prefer a hardcopy version of this information, instructions are provided here on how to print the
PDF files.

• 

HMC concepts for managing servers
Learn about the concepts that you need to know before you use the HMC to work with managed
systems.

• 

Working with managed systems and frames
Learn how to perform actions on the HMC that pertain to the managed system.

• 

Using the Network Manager
Learn how to use the Network Manager to manage InfiniBand (IB) networks.

• 

Related information
Review technical and "how-to" information.

• 

Parent topic: Managing your server, adapters, and devices

What's new

Learn about new and improved information in Managing your server using the HMC.

The following information highlights newly released or improved content for the Managing your server using
the Hardware Management Console (HMC) topic.

Adding managed systems to the HMC environment
This information has been improved to take you directly to the information you need to know to add a
managed system to your HMC environment depending on your existing network configuration.

Change in parent topic name in the table of contents
If you use the table of contents to navigate to this topic in the Hardware ESCALA Power5 Hardware
Information, note that the name for the parent topic has changed to Managing your server, adapters,
and devices (adapters has been added to the title).
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Parent topic: Managing your server using the Hardware Management Console

Printable PDFs

If you prefer a hardcopy version of this information, instructions are provided here on how to print the PDF
files.

To view or download the PDF version of this document, select Managing your server using the Hardware
Management Console .

You can also view or download these related topics in the PDF version:

Managing the Hardware Management Console (2893)• 

Partitioning the server:
Partitioning for AIX (486 KB)♦ 

Partitioning for Linux with an HMC (419 KB)♦ 

Using the Virtual I/O server (1034 KB)♦ 

• 

Working with Power On Demand (1068 KB)• 

Customer service, support, and troubleshooting (5200 KB)• 

Saving PDF files

To save a PDF file on your workstation for viewing or printing:

Right-click the PDF link in your browser.1. 
Click the option that saves the PDF locally.2. 
Navigate to the directory in which you would like to save the PDF file.3. 
Click Save.4. 

Downloading Adobe Reader

You need Adobe Reader installed on your system to view or print these PDFs. You can download a free copy
from the Adobe Web site (www.adobe.com/products/acrobat/readstep2.html).

Parent topic: Managing your server using the Hardware Management Console

HMC concepts for managing servers

Learn about the concepts that you need to know before you use the HMC to work with managed systems.

The HMC allows you to perform a variety of tasks associated with managing your servers and frames. This
information familiarizes you with the HMC concepts that you should know before working with the managed
systems.

Overview of HMC tasks
Learn about the tasks that you can perform using the HMC, the user role needed to perform each
task, and the remote command associated with each task.

• 

Managed system power-on and power-off modes
Learn about the power-on options and the power-off options for a managed system.

• 

Managing your server, adapters, and devices
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Managed system states
Learn about the operational states that are displayed for managed systems in the HMC.

• 

Frame states
Learn about the various operational states that are displayed for frames in the HMC.

• 

Parent topic: Managing your server using the Hardware Management Console

Overview of HMC tasks

Learn about the tasks that you can perform using the HMC, the user role needed to perform each task, and
the remote command associated with each task.

See the HMC commands topic for HMC command descriptions.

The following tables list all of the tasks that you can perform using the HMC, the user role needed to perform
each task, and the remote command associated with each task. Click one of the following links to learn more
about the associated task grouping:

Managed system profile tasks
Learn about the managed-system profile tasks and the roles that can perform them.

• 

Managed system tasks
Learn about the tasks that enable you to manage your server operations and the roles that can
perform these tasks.

• 

Logical partition tasks
Learn about the logical partition tasks and the roles that can perform them.

• 

Power On Demand tasks
Learn about the Power On Demand tasks and the roles that can perform them.

• 

Virtualization Engine Technologies tasks
Learn about Virtualization Engine Technologies tasks and the roles that can perform them.

• 

System planning tasks
Learn about the tasks associated with creating and deploying a system plan and the roles that can
perform them.

• 

Utilization data management tasks
Learn about the management tasks concerned with the collection of system utilization data and the
roles that can perform them.

• 

Frame tasks
Learn about tasks that you can perform to manage your frames and the roles required to perform
them.

• 

Service tasks
Learn about problem determination tasks and the roles that can perform them.

• 

Parent topic: HMC concepts for managing servers

Managed system profile tasks

Learn about the managed-system profile tasks and the roles that can perform them.

The following table lists the managed system profile tasks, the associated commands, and the user roles
necessary to perform them.

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

Activate a
system profile

chsysstate X X X X

mksyscfg X X

Managing your server, adapters, and devices
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Create a
system profile
on a
managed
system

Modify the
properties of
a system
profile

chsyscfg X X X

Power on a
managed
system using
a system
profile

chsysstate X X X X

Remove a
system profile

rmsyscfg X X

Validate a
system profile

chsysstate X X X X

View a
system profile

lssyscfg X X X X X

For more information about system profiles, see System profile. For more information about using the
commands, see Using the remote command line.

Parent topic: Overview of HMC tasks

Managed system tasks

Learn about the tasks that enable you to manage your server operations and the roles that can perform these
tasks.

The following table describes the managed system tasks, the associated commands, and the user roles
necessary to perform them.

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

Add a
managed
system

mksysconn X X X

Back up
profile data

bkprofdata X X X X

Create a
network
connection
with a system

mksysconn X X X

Enable a
remote
service
session for a
logical
partition

chsysstate X X X X

Managing your server, adapters, and devices
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Enable or
disable
service
processor
failover on a
managed
system

chsyscfg X X X

Initialize
profile data

rstprofdata X X

Migrate
logical
partition
configuration
data to a
managed
system

migrcfg X X X

Modify the
keylock
position of a
managed
system

chsysstate X X X X

Modify the
properties of a
managed
system

chsyscfg X X X

Modify virtual
I/O attributes
of a managed
system

chhwres X X X X

Power a
managed
system on
and off

chsysstate X X X X

Rebuild a
managed
system

chsysstate X X X X

Recover
partition data
for a
managed
system

chsysstate X X X X

Remove the
network
connection to
a managed
system

rmsysconn X X X

Request
huge-page
memory for a
managed
system

chhwres X X X X

Reset the
network
connection to
a managed
system

rmsysconn X X X

Restart a
managed
system

chsysstate X X X X

Restore the
hardware

rsthwres X X X X

Managing your server, adapters, and devices
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resource
configuration
of a managed
system
following a
DLPAR task
failure

Restore
profile data

rstprofdata X X

Update a
password for
a managed
system

chsyspwd X

Update the
LIC on a
managed
system

updlic X X X

View
connections
for a
managed
system

lssysconn X X X X X

View the
current state
of readiness
for service
processor
failover on a
managed
system

lssyscfg X X X X X

View HCA
adapter
resources of a
managed
system

lshwres X X X X X

View
hardware
resources of a
managed
system

lshwres X X X X X

View I/O
resources of a
managed
system

lshwres X X X X X

View LIC
levels
accepted on a
managed
system

lslic X X X X X

View LIC
levels
activated on a
managed
system

lslic X X X X X

View LIC
levels that are
available to
be retrieved

lslic X X X X X

View
Licensed
Internal Code
(LIC) levels

lslic X X X X X

Managing your server, adapters, and devices
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installed on a
managed
system

View
managed
systems

lssyscfg X X X X X

View memory
resources of a
managed
system

lshwres X X X X X

View
processing
resources of a
managed
system

lshwres X X X X X

View
reference
codes for a
managed
system

lsrefcode X X X X X

View SNI
adapter
resources of a
managed
system

lshwres X X X X X

View virtual
I/O resources
of a managed
system

lshwres X X X X X

For more information about working with your managed system using your HMC, see Working with managed
systems and frames. For more information about using commands, see Using the remote command line.

Parent topic: Overview of HMC tasks

Logical partition tasks

Learn about the logical partition tasks and the roles that can perform them.

The following table describes the tasks that you can execute from the HMC to manage logical partitions. This
table provides the commands and the user roles necessary to perform the tasks from the remote command
line.

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

Activate a
logical
partition

chsysstate X X X X

Change the
default
partition
profile for a

chsyscfg X X X

Managing your server, adapters, and devices
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logical
partition

Close a virtual
terminal
session for an
AIX, Linux, or
Virtual I/O
Server
partition

rmvterm X X X X

Create a
logical
partition on a
managed
system

mksyscfg X X X

Create a
logical
partition
profile on a
managed
system

mksyscfg X X X

Create a
Virtual I/O
Server

mksyscfg X X X

Issue a
command to a
Virtual I/O
Server

viosvrcmd X X X X

Modify
memory
resources of a
logical
partition

chhwres X X X X

Modify
processing
resources of a
logical
partition

chhwres X X X X

Modify the
properties of a
logical
partition
profile

chsyscfg X X X

Modify the
hardware
resource
configuration
of a logical
partition

chhwres X X X X

Modify the I/O
resources of a
logical
partition

chhwres X X X X

Modify the
keylock
position on a
logical
partition

chsysstate X X X X

Modify the
properties of a
logical
partition

chsyscfg X X X

Managing your server, adapters, and devices

8 HMC concepts for managing servers



Modify virtual
I/O resources
of a logical
partition

chhwres X X X X

Open a virtual
terminal
session for an
AIX, Linux, or
Virtual I/O
Server
partition

mkvterm X X X X

Perform a
Dynamic
Logical
Partitioning
task

chhwres X X X X

Perform a
network boot
of a logical
partition

lpar_netboot X X X X

Perform an
operator
panel function
on a logical
partition

chsysstate X X X X

Remove a
logical
partition from
the managed
system

rmsyscfg X X X

Remove a
logical
partition
profile

rmsyscfg X X X

Restart a
logical
partition

chsysstate X X X X

Retrieve MAC
address and
location code
for a partition

lpar_netboot X X X X

Shut down a
logical
partition

chsysstate X X X X

View HCA
adapter
resources of a
logical
partition

lshwres X X X X X

View I/O
resources of a
logical
partition

lshwres X X X X X

View logical
partition
profiles

lssyscfg X X X X X

View logical
partitions

lssyscfg X X X X X

View
processing
resources of a

lshwres X X X X X

Managing your server, adapters, and devices
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logical
partition

View memory
resources of a
logical
partition

lshwres X X X X X

View
reference
codes for a
logical
partition

lsrefcode X X X X X

View SNI
adapter
resources of a
logical
partition

lshwres X X X X X

View virtual
I/O resources
of a logical
partition

lshwres X X X X X

For more information about logical partitions, see Partitioning the server. For more information on using
commands, see Using the remote command line.

Parent topic: Overview of HMC tasks

Power On Demand tasks

Learn about the Power On Demand tasks and the roles that can perform them.

The following table lists the Power On Demand tasks, the associated command for each task, and the user
roles necessary to perform the task.

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

Activate POD
resources

chcod X

Deactivate
POD
resources

chcod X

Enter a POD
code

chcod X

Manage
On/Off POD
resources

chcod X

Manage
Reserve POD
processors

chcod X

Stop Trial
POD

chcod X

lscod X X X X X

Managing your server, adapters, and devices
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View POD
capacity
settings for a
managed
system

View POD
code
generation
information for
a managed
system

lscod X X X X X

View On/Off
POD billing
information for
a managed
system

lscod X X X X X

View the POD
history log for
a managed
system

lscod X X X X X

View shared
processor
pool utilization
information for
Reserve POD

lscod X X X X X

For more information about Power On Demand, see Working with Power On Demand. For more information
about using the commands, see Using the remote command line.

Parent topic: Overview of HMC tasks

Virtualization Engine Technologies tasks

Learn about Virtualization Engine Technologies tasks and the roles that can perform them.

The following table lists the Virtualization Engine Technologies tasks, the associated commands, and the user
roles necessary to perform them.

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

View the
Virtualization
Engine
systems
technologies
activation
history log

lsvet X X X X X

Enter
Virtualization
Engine
systems
technologies
activation

chvet X

Managing your server, adapters, and devices
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code

View
information
used to
generate a
Virtualization
Engine
systems
technologies
activation
code

lsvet X X X X X

For more information about creating a Virtualization Engine Technologies environment, see Using a virtual
computing environment. For more information about using commands, see Using the remote command line.

Parent topic: Overview of HMC tasks

System planning tasks

Learn about the tasks associated with creating and deploying a system plan and the roles that can perform
them.

The following table lists the tasks that you can use when working with a system plan to set up a managed
system, the associated commands, and the user roles necessary to perform them.

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

Export a
system plan
for a
managed
system

cpsysplan X

Import a
system plan
for a
managed
system

cpsysplan X

List system
plans

lssysplan X

Remove a
system plan
for a
managed
system

rmsysplan X

Deploy a
system plan
to a managed
system

deploysysplan X

Create a
system plan

mksysplan X

Managing your server, adapters, and devices
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For information about how to view a system plan before you deploy it, see Deploying a system plan. For more
information about using the commands from the HMC command line, see Using the remote command line.

Parent topic: Overview of HMC tasks

Utilization data management tasks

Learn about the management tasks concerned with the collection of system utilization data and the roles that
can perform them.

The following table lists the tasks associated with viewing and managing system utilization data, the
associated commands, and the user roles necessary to perform them.

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

Change the
settings for
utilization-data
collection for a
managed
system

chlparutil X X X X

Remove the
utilization data
collected for a
managed
system

rmlparutil X X X X

View utilization
data for a
managed
system

lslparutil X X X X X

For more information about using the commands, see Using the remote command line.

Parent topic: Overview of HMC tasks

Frame tasks

Learn about tasks that you can perform to manage your frames and the roles required to perform them.

The following table describes frame tasks, associated commands, and the roles that can perform each task:

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

Managing your server, adapters, and devices
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Add a
managed
frame

mksysconn X X X

Create a
network
connection
with a frame

mksysconn X X X

Force an HMC
to release its
lock on a
managed
frame

rmlock X X

Modify the
properties of a
managed
frame

chsyscfg X X X

Power off all
unowned I/O
units in a
managed
frame

chsysstate X X X X

Rebuild a
managed
frame

chsysstate X X X X

Reset the
network
connection to
a managed
frame

rmsysconn X X X

Remove the
network
connection to
a managed
frame

rmsysconn X X X

Update a
password for a
managed
frame

chsyspwd X

View which
HMC owns the
lock on a
managed
frame

lslock X X X X X

View managed
frames

lssyscfg X X X X X

View
environmental
information for
a managed
frame

lshwinfo X X X X X

View
connections
for a managed
frame

lssysconn X X X X X

For more information about using commands, see Using the remote command line.

Parent topic: Overview of HMC tasks

Managing your server, adapters, and devices
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Service tasks

Learn about problem determination tasks and the roles that can perform them.

The following table describes the service tasks that you can perform in the HMC. The associated command
and required user role for performing the task are also provided.

Task Associated
command

Roles

super
administrator

service
representative

operator product
engineer

viewer

Activate
dedicated
service tools
(DST) on a
logical
partition

chsysstate X X X X

Clear all
partition
configuration
data on a
managed
system

lpcfgop X X

Copy a
managed
system or
frame dump
from the HMC
to DVD or a
remote FTP
server

cpdump X X X X

Disable a
remote
service
session for a
logical
partition

chsysstate X X X X

Dump all
logical
partition
configuration
data on a
managed
system

lpcfgop X X

Dump IOP
control
storage

chsysstate X X X X

Enable a
remote
service
session for a
logical
partition

chsysstate X X X X

Enable or
disable
service
processor
failover on a
managed

chsyscfg X X X

Managing your server, adapters, and devices
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system

Initiate a
service
processor
failover

chsysstate X X X X

Launch the
Advanced
System
Management
(ASMI) menu

asmmenu X X X

Modify the
state of an
LED on a
managed
system

chled X X X

Modify the
state of a
logical
partition LED

chled X X X

Modify
Service Agent
customer
email
notification
settings

chsacfg X X X X

Modify
Service Agent
FTP firewall
settings

chsacfg X X X X

Modify
Service Agent
FTP offload
server
settings

chsacfg X X X X

Perform an
operator
panel service
function on a
logical
partition

chsysstate X X X X

Reset or
reload a disk
unit IOP

chsysstate X X X X

Retrieve a
dump from a
managed
system or
frame

getdump X X X X

Save and
display an
image of an
HMC window

hmcwin X X X X X

Start a dump
on a managed
system or
frame

startdump X X X X

Transfer a file
from the HMC
to a remote
system using
File Transfer

sendfile X X X X X

Managing your server, adapters, and devices
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Protocol

Update a
serviceable
event on the
HMC

chsvcevent X X X X

View available
dumps on a
managed
system or
frame

lsdump X X X X X

View LED
resources of a
logical
partition

lsled X X X X X

View LED
resources of a
managed
system

lsled X X X X X

View
serviceable
events for a
managed
system

lssvcevents X X X X X

View
reference
codes for a
logical
partition

lsrefcode X X X X X

View
reference
codes for a
managed
system

lsrefcode X X X X X

View Service
Agent
customer
email
notification
settings

lssacfg X X X X X

View Service
Agent FTP
firewall
settings

lssacfg X X X X X

View Service
Agent FTP
offload server
settings

lssacfg X X X X X

View
managed
system or
managed
frame dumps
residing on
the HMC

lsdump X X X X X

View the
current state
of readiness
for service
processor
failover on a
managed
system

lssyscfg X X X X X

Managing your server, adapters, and devices
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For more information about service and support, see  Overview of service and support. For more information
about using commands, see Using the remote command line.

Parent topic: Overview of HMC tasks

Managed system power-on and power-off modes

Learn about the power-on options and the power-off options for a managed system.

This topic describes the power-on options and the power-off options that are available for starting and shutting
down a managed system using a console.

The following table describes the power-on options. Power-off options are also available and described in a
second table below.

Power-on mode Description

Partition standby Use this mode to create and activate logical partitions. When the
partition standby power-on is completed, the operator panel on the
managed system displays Partition Standby, indicating the
managed system is ready for you to use the HMC to partition its
resources.

Note: Autostart partitions will not start if you power on using this mode.

For more information about logical partitions, see Partitioning the
server.

System profile This option powers on the system according to a predefined set of
profiles.

Note: The profiles are activated in the order in which they are shown in
the system profile.

For more information about system profiles, see System profile.

Partition autostart This option activates logical partitions that have been previously
designated as autostart.

For more information about logical partitions, see Partitioning the
server.

For more information about powering on the managed system, see Powering on a managed system.

Managing your server, adapters, and devices
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Use the following power-off options for shutting down a managed system.

Power-off mode Description

Normal power off The Normal power off mode shuts down the system's operations in a
controlled manner. During the shutdown, programs running active jobs
are allowed to perform cleanup (end-of-job processing).

Fast power off The Fast power off mode shuts down the system by stopping all active
jobs immediately. The programs running those jobs are not allowed to
perform any cleanup. Use this option when you need to shut down the
system because of an urgent or critical situation.

Parent topic: HMC concepts for managing servers

Managed system states

Learn about the operational states that are displayed for managed systems in the HMC.

You can monitor the current state of a system (server or frame) that is connected to the HMC. The state for
each system that you are managing is displayed in the Contents area of the HMC window, in the column
labeled State.

The following table describes the various states for managed systems. To view the states for frames, see
Frame states.

State Description

Power off The managed system is powered off.

Operating The managed system is powered on and functioning correctly.

Initializing The managed system is powering on.

Error The managed system's operating system or hardware is experiencing
errors. See Correcting the managed system operating state.

Error - Dump in Progress The managed system has started a system dump. When the dump is
complete, see Managing dumps in the Troubleshooting topic.

Error - Terminated The power-on operation failed.

Incomplete The HMC failed to get all of the necessary information from the
managed system. The managed system is not responding to requests
for information. See Correcting the managed system operating state.

Pending Authentication - Password
Updates Required

The managed system passwords have not been set. You must set the
required passwords for the managed system, to enable secure
authentication and access control from the HMC. See Overview of
passwords for information about setting the required passwords.

Failed Authentication The HMC access password for the managed system is not valid. Enter
a valid password for the managed system. See Overview of passwords
for more information about the HMC access password.

Recovery The partition data and profile data stored in the managed system is
damaged. See Correcting the managed system operating state.

No Connection The HMC cannot contact the managed system. See Correcting the
managed system operating state.

Standby The managed system was powered on using the partition standby
power-on option.

Managing your server, adapters, and devices
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On Demand Recovery The anchor card has been replaced; activation codes for Power On
Demand must be entered again.

Parent topic: HMC concepts for managing servers

Frame states

Learn about the various operational states that are displayed for frames in the HMC.

The following table describes the states for frames that the HMC displays in the Contents area under the
State label.

State Description

Starting/Unknown One of the bulk power assemblies (BPAs) contained in the frame is in
the process of starting. The state of the other BPA cannot be
determined.

Standby/Standby Both of the bulk power assemblies (BPAs) contained in the frame are in
the standby state. A BPA in the standby state is operating normally.

Standby/Starting One of the bulk power assemblies (BPAs) contained in the frame is
operating normally (in standby state). The other BPA is in the process
of starting.

Standby/Not Available One of the bulk power assemblies (BPAs) contained in the frame is
operating normally (in the standby state), but the other BPA is not
operating normally.

Pending frame number A change to the frame number is in progress. No operations can be
performed when the frame is in this state.

Failed Authentication The HMC access password for the frame is not valid. Enter a valid
password for the frame. See Overview of passwords for more
information about the HMC access password.

Pending Authentication - Password
Updates Required

The frame access passwords have not been set. You must set the
required passwords for the frame, to enable secure authentication and
access control from the HMC. See Overview of passwords for
information about setting the required passwords.

No Connection The HMC cannot connect to the frame.

Incomplete The HMC failed to get all of the necessary information from the
managed frame. The frame is not responding to requests for
information. See Correcting the managed system operating state.

Note: For information about the operational states of the managed systems contained in the frame, see
Managed system states.

Parent topic: HMC concepts for managing servers
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Working with managed systems and frames

Learn how to perform actions on the HMC that pertain to the managed system.

You can use the HMC to communicate with the managed systems and frames in your environment. For
example, you can use power-on options to start and shut down your managed systems, and to monitor
system states.

Use the information in this topic to learn more about the tasks that you can perform using the HMC to work
with the managed system and frames.

Powering on and off a managed system
Read about how to use the HMC to power on and off a managed system. Also find information about
scheduling managed-system power operations.

• 

Accessing a managed system
Learn how to access a managed system from the HMC after the HMC has been connected to it.

• 

Enabling service processor failover
Enable a secondary service processor if your managed system's primary service processor fails.

• 

Setting huge-page memory values
Specify the number of 16-GB pages to allocate to a huge-page memory pool.

• 

Virtual operating system consoles
Learn how to use virtual operating system consoles on your HMC.

• 

Finding and updating managed systems data on the HMC
Find and update managed-system information that is displayed on the HMC interface. Also, learn
more about working with managed system profile data.

• 

Managing frames using the HMC
Learn about the tasks that you can use to manage your frames in the HMC.

• 

Managing operating systems
Understand how you can use the HMC to interact with the operating systems running on the managed
systems.

• 

Adding managed systems to the HMC environment
Understand how to add managed systems to the HMC, so that you can manage them using the HMC
interface.

• 

Deleting a managed system
Disconnect a managed system from the HMC before you physically detach it from the HMC.

• 

Moving the managed system from an open network to a private network
Learn how to move a managed system that is attached to an HMC on an open network to an HMC
that is located on a private network.

• 

Servicing the managed system
Understand how you can use the HMC to perform service actions.

• 

Parent topic: Managing your server using the Hardware Management Console

Powering on and off a managed system

Read about how to use the HMC to power on and off a managed system. Also find information about
scheduling managed-system power operations.

You can use the HMC to control the power on a managed system. The following tasks describe these
activities:

Note: For information about the power-on states that display for managed systems in the HMC, see Managed
system states.

Powering on a managed system
Understand how to power on a managed system using the HMC.

• 

Powering off a managed system
Understand how to use the HMC to power off a managed system.

• 

Scheduling power-on and power-off operations for a managed system
Use the HMC to schedule power on and off operations for a managed system.

• 
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Parent topic: Working with managed systems and frames

Powering on a managed system

Understand how to power on a managed system using the HMC.

You can use the HMC to power on a managed system and to monitor the power-on state.

To power on a managed system, you must be a member of one of the following roles:

super administrator• 

service representative• 

operator• 

product engineer• 

To power on a managed system, complete the following steps:

In the Navigation area, expand the Server and Partition folder.1. 
Click the Server Management icon.2. 
In the Contents area, select the managed system.3. 
From the menu, click Selected > Power On.4. 
Select the desired power-on mode and click OK.5. 

For more information about each power-on mode, see Managed system power-on and power-off modes.

Parent topic: Powering on and off a managed system

Powering off a managed system

Understand how to use the HMC to power off a managed system.

By default, the managed system is set to power off automatically when you shut down the last running logical
partition on the managed system. If you set the managed system properties on the HMC so that the managed
system does not power off automatically, you must use this procedure to power off your managed system.

Attention: If possible, shut down the running logical partitions on the managed system before powering off
the managed system. Powering off the managed system without shutting down the logical partitions first
causes the logical partitions to shut down abnormally and can cause data loss.

For more information about shutting down your logical partitions, see the following topics:

Shutting down AIX• 

Shutting down Linux• 

To power off a managed system, you must be a member of one of the following roles:

super administrator• 
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service representative• 

operator• 

product engineer• 

To power off the managed system, complete the following steps:

In the Navigation area, expand the Server and Partition folder.1. 
Click the Server Management icon.2. 
In the Contents area, select the managed system.3. 
From the menu, click Selected > Power Off.4. 
Select the desired power-off mode and click OK.5. 

For more information about the power-off modes, see Managed system power-on and power-off modes.

Parent topic: Powering on and off a managed system

Scheduling power-on and power-off operations for a managed system

Use the HMC to schedule power on and off operations for a managed system.

You can power your managed system on and off at regular intervals by scheduling an operation using the
HMC.

To schedule a power on or off operation for the managed system using your HMC, complete the following
steps:

In the Navigation area, expand the HMC Management folder.1. 
In the Navigation area, click the HMC Configuration icon.2. 
In the Contents area, click Schedule Operations.3. 
From the list, select the managed system for which you want to schedule an operation and click OK.4. 
Select Options > New.5. 
In the Add a Scheduled Operation window, select the managed system power operation that you want
to perform and click OK.

6. 

In the appropriate fields, enter the time and date that you want this managed system power operation
to occur.

7. 

If you want this scheduled operation to repeat, click the Repeat tab and select the intervals at which
you want the power operation to repeat.

8. 

When you are finished, click Save.9. 

Parent topic: Powering on and off a managed system

Accessing a managed system

Learn how to access a managed system from the HMC after the HMC has been connected to it.

This topic describes how to access the managed system for the first time, after you have connected the HMC
to the managed system and powered on the managed system.

The following topics explain more about accessing your managed system using the HMC.

Overview of passwords• 

Managing your server, adapters, and devices

24 Working with managed systems and frames



Virtual operating system consoles• 

For more information about connecting the HMC, see Setting up the Hardware Management Console.

For more information about the Advanced System Management Interface (ASMI), see Managing your server
using the Advanced System Management Interface.

Overview of passwords
Describes the passwords that you need in order to access a managed system using your HMC.

• 

Changing the managed system's password
Update a managed system's password using the HMC.

• 

Parent topic: Working with managed systems and frames

Overview of passwords

Describes the passwords that you need in order to access a managed system using your HMC.

The first time you access a managed system using an HMC, the system prompts you to enter passwords for
each of the following:

Hardware Management Console: HMC access• 

Advanced System Management Interface: General• 

Advanced System Management Interface: Admin• 

If all required passwords are not set, the state of the managed system displays Pending Authentication � �
Password Updates Required until these passwords are set.

To change the managed system's password, see Changing the managed system's password.

If you are using an HMC to access the managed system before all required passwords have been set, enter
the appropriate password for each password that is presented in the Update Password Pending
Authentication window. If another HMC subsequently needs access to this managed system, upon attempting
to access this HMC the user is presented with the Update Password Failed Authentication window, which will
prompt for the HMC access password you entered.

In the event that the HMC access password changes while you are logged in to the managed system, your
HMC will discover that it can no longer authenticate after it attempts to reconnect to that managed system.
This will result in a state of Failed Authentication for that managed system. You will be required to enter the
new password before any actions can be performed.

For more information about the Advanced System Management Interface (ASMI), see Managing your server
using the Advanced System Management Interface.

Parent topic: Accessing a managed system

Changing the managed system's password

Update a managed system's password using the HMC.

You can use the HMC interface to change a managed system's HMC access password. If you change this
password, you must change the password for any other HMCs that connect to this managed system.

The super administrator user role is required to change this password.

To change the managed system's HMC access password, complete the following steps:
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In the Navigation area, expand the Server and Partition folder.1. 
In the Navigation area, click the Server Management application icon.2. 
In the Contents area, right-click the managed system and then select Update Managed System
Password.

3. 

Type in your current password and new password in the entry fields.4. 
Click OK.5. 

For information about additional passwords that must be set before you can perform any tasks, see Overview
of passwords.

Parent topic: Accessing a managed system

Enabling service processor failover

Enable a secondary service processor if your managed system's primary service processor fails.

You can use your HMC to have your managed system automatically enable a secondary service processor if
your managed system's primary service processor fails.

To enable service processor failover, you must be a member of one of the following roles:

super administrator• 

service representative• 

operator• 

product engineer• 

To enable service processor failover, complete the following steps:

In the Navigation area, expand the Server and Partition folder.1. 
Click the Server Management icon.2. 
In the Contents area, right-click the managed system or frame.3. 
Select Status.4. 
In the Service Processor Connection Status window, click Service processor failover enabled.5. 
Click OK.

In the error log, an informational SRC of B1xxE66C indicates that the primary service processor in the
managed system has performed an administrative failover and transferred system management to the
secondary service processor. The error log entry that contains this SRC is created in the primary
service processor's error log and copied over to the secondary service processor's error log.

6. 

Initiating a service processor failover
Force a failover after enabling the service processor failover mode on your managed system.

• 

Parent topic: Working with managed systems and frames

Initiating a service processor failover

Force a failover after enabling the service processor failover mode on your managed system.

After enabling service processor failover mode on a managed system, you can use your HMC to initiate a
failover. This task is useful for forcing a failover to test that the secondary processor is activated during a
failover event. The service processor readiness state must be ready before you can initiate a failover.
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To initiate a service processor failover, you must be a member of one of the following roles:

super administrator• 

service representative• 

product engineer• 

To initiate a service processor failover, complete the following steps:

In the Navigation area, expand the Service Applications folder.1. 
Click Service Focal Point and select Service Utilities from the Tasks list.2. 
In the Service Utilities dialog box, select the managed system and click Selected from the Service
Utilities menu.

3. 

Select Service Processor Failover.4. 
In the Administrative Processor Failover dialog box, ensure that the service processor failover is
enabled and the readiness state is ready.

5. 

Click OK.

In the error log, an informational SRC of B1xxE66C indicates that the primary service processor in the
managed system has performed an administrative failover and transferred system management to the
secondary service processor. The error log entry that contains this SRC is created in the primary
service processor's error log and copied over to the secondary service processor's error log.

6. 

Parent topic: Enabling service processor failover

Setting huge-page memory values

Specify the number of 16-GB pages to allocate to a huge-page memory pool.

On managed systems that support huge-page memory, you can use the Hardware Management Console
(HMC) to set the value for the huge-page memory pool. You can also specify values for the number of huge
pages to allocate to logical partitions.

Using huge pages can improve performance in specific environments that require a high degree of
parallelism, such as in DB2 partitioned database environments. You can specify huge-page memory that can
be used for the shared-memory buffer pools in DB2. For logically partitioned systems, you can specify the
minimum, desired, and maximum number of huge pages to assign to a partition when you create the partition
or partition profile. See Creating logical partitions and partition profiles.

To set the huge-page memory values, the system must be in the powered-off state. The new value will take
effect when you restart the system.

Use the following information to determine the requirements and appropriate values for your specific
application, and to set the huge-page values.

Calculating huge-page memory requirements
Calculate the value for the number of pages to allocate to a huge-page memory pool.

• 

Viewing and setting huge page memory values
View and set values for huge-page memory allocation.

• 

Parent topic: Working with managed systems and frames
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Calculating huge-page memory requirements

Calculate the value for the number of pages to allocate to a huge-page memory pool.

To use huge-page memory, you must ensure that your system has adequate memory resources to dedicate
to the huge-page memory pool. The huge-page memory pool is a region of system memory that is mapped as
16-GB page segments and is managed separately from the system's base memory. Before you can specify
the value for huge-page memory, you must determine which applications you are running and what the
huge-page requirements are for your applications.

Determining huge-page memory requirements for your application

The huge-page memory pool can be used to enhance performance for DB2 partitioned database
environments in AIX operating systems. For DB2 applications, you would typically use huge pages for large
DB2 multipartitioned database environments to efficiently support the degree of parallel activity required of
shared memory buffer pools. To determine this value, calculate the amount of memory required for the shared
buffer pool to support your DB2 applications. Refer to the DB2 recommendations for buffer pool memory for
your particular application.

In logically partitioned systems, you can assign huge-page memory when you create the partitions. This value
is separate from the value that you specify for the configured-partition memory region. You can specify a
minimum, desired, and maximum value. To determine the number of huge pages needed for your logical
partitions, see the section below that discusses calculating huge page values.

Note: The huge page memory allocation cannot be changed dynamically. Changing the number of huge
pages on the server requires a server reboot, and changing the number of assigned huge pages for a partition
requires a partition reboot.

Considerations for calculating the huge page values

The amount of huge-page memory that you can allocate is dependent on the following factors:

Total amount of licensed memory for your server• 

Amount of available memory after configured memory resources are accounted for• 

Number of physical IO connections to the server (each IO connection requires memory for the IO
tables, which can be distributed among the physical memory regions and reduces the memory
available for huge pages)

• 

Base memory configuration for logical partitions (huge pages are not calculated as part of the
configured-partition memory allocation)

• 

The requirements that define a huge page, that is each huge page requires 16 GB of contiguous real
memory and must start on a 16-GB memory boundary

• 

Attention: The server firmware will reduce the huge-page pool size to satisfy some of these dependencies.
When this occurs, error log entries are generated to indicate that the huge-page pool size was reduced. The
error log reference code is B700 5300. The reference code details will indicate hexadecimal values that
indicate why the huge-page pool size could not be satisfied. The following example shows the possible entries
and how to interpret the additional words in these entries:

word 3 = 0x0000000100000106 - huge page pool reduced to satisfy system hardware configuration
word 4 = number of user-configured huge pages♦ 

word 5 = number of huge pages that could be provided♦ 

• 

word 3 = 0x0000000100000105 - huge page pool reduced to satisfy the memory configuration of
partitions

word 4 = number of huge pages before partitions were created♦ 

word 5 = firmware calculated number of huge pages after satisfying partition memory
requirements

♦ 

word 6 = number of huge pages in the pool♦ 

• 
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Calculating huge-page memory values

To calculate the server memory requirements to support huge pages, use the following steps:

Determine the amount of base system memory and round that figure to the next 16-GB value. To
determine the base server memory requirements, which includes the POWER hypervisor and
partition, but not huge pages, use the LPAR Validation tool (LVT) or System Planning Tool. See
Planning for logical partitions for information about using these planning tools.

1. 

Determine the number of IO connection loops on your system and multiply the number by 16 GB. This
calculation is required because the server needs a memory table for each IO connection, and a
16-GB huge page cannot be located where an IO table exists.

2. 

Take the larger of the values determined in step 1 and step 2. This will be your base memory value.3. 
Determine the number of huge pages that will be required for your AIX applications. To determine this
value, use the guidelines provided by your application documentation and the AIX Performance
Management Guide. Multiply the number of anticipated huge pages by 16 GB. Add this figure to the
base figure determined in step 3. The resulting figure provides an estimate of the amount of licensed
memory required to satisfy partition and huge-page pool memory requirements for your system.

4. 

Parent topic: Setting huge-page memory values

Viewing and setting huge page memory values

View and set values for huge-page memory allocation.

On systems that support huge-page (16 GB) memory allocation, you can view and set the current value in the
huge-page memory table. On a new system you must set this value initially to establish the huge-page
memory pool. You must set the value when the managed system is in the powered-off state. If this value is
already set, you might need to change the value to adjust for performance needs based on the applications
that you are running and your partitioning configurations. You can also change the values set for the number
of huge pages allocated to your logical partitions.

Use this task to view huge-page values and to set or adjust the number of 16-GB pages for the huge-page
allocation according to your needs. Before setting a value, review the information in Calculating huge-page
memory requirements.

To view or change huge-page-memory table values, you must be a member of one of the following roles:

super administrator• 

service representative• 

Note: You must power off the managed system before you can change the huge page memory value for the
system. To change the values for logical partitions you must shut down the partition. The new value will take
effect when you restart the system.

To view or set huge-page memory values, complete the following steps:

In the Navigation area, expand the Server and Partition folder.1. 
Click the Server Management icon.2. 
In the Contents area, select the managed system.3. 
In the menu click Selected, and choose Properties.4. 
In the Managed System Properties dialog box, view the Capabilities information to determine if huge
page memory allocation is supported on the managed system. Click the Memory tab to view or

5. 
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change the huge page memory allocation displayed under Advanced Options. If the information is not
displayed in the Advanced Options area, click Show details.

Note: You can view and change the current settings for huge-page minimum, desired, and maximum
values for logical partitions by viewing the partition properties. See Modifying partition properties for
further details.

Parent topic: Setting huge-page memory values

Virtual operating system consoles

Learn how to use virtual operating system consoles on your HMC.

You can connect to logical partition operating systems, for example to manage resources, by using your HMC
interface to open a virtual console window. The following task explains how to verify that consoles are
configured.

Parent topic: Working with managed systems and frames

Finding and updating managed systems data on the HMC

Find and update managed-system information that is displayed on the HMC interface. Also, learn more about
working with managed system profile data.

This topic describes how to find information about each of the managed systems that are attached to the
HMC. Also, learn how to perform tasks to ensure the integrity of the managed system data maintained by the
HMC.

Viewing information about the managed system
View information about the managed system's configuration and capabilities.

• 

Viewing resource utilization for a managed system
Use this procedure to view the resource utilization data for a managed system using the Hardware
Management Console (HMC).

• 

Updating managed system or frame information
Update the system information for a managed system or frame in the HMC that is in an Incomplete
state.

• 

Disconnecting another HMC connection
Read about how to manually unlock an HMC locked connection to the managed system.

• 

Recovering partition data on a managed system
Learn how to recover the partition data on your managed system if it becomes corrupted.

• 

Parent topic: Working with managed systems and frames

Viewing information about the managed system

View information about the managed system's configuration and capabilities.

You can view the managed system's configuration and capabilities. To view information about the managed
system, expand the Server and Partition folder in the Navigation area. Then, click the Server Management
icon. The Contents area expands to show each managed system, which you can then expand to show
information about the managed system, including its name, its state, and the operator panel value.

Any user can view managed system properties.
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To expand your view of the managed system's properties, click the plus sign (+) next to the managed
system's name to view its contents.

To view the detailed managed system properties, do the following:

In the Contents area, select the managed system.1. 
From the menu, click Selected.2. 
Click Properties.

The HMC displays the system's name, logical partition capability, state, serial number, model and
type, and policy information. A system that is powered on using the Partition Standby option displays
this information, as well as available and assigned processors, memory, I/O drawers and slots,
power-on parameters, reference codes, and policy information. The HMC also displays power-on
parameters and reference codes for a managed system in the power-off state.

The Processor tab displays information that is helpful when performing Dynamic Logical Partitioning
processor tasks. Use the Processor tab to view processor usage data for partitions and determine
whether a processor is assigned to a logical partition. The information in the Processor tab is also
helpful when you need to know if processors are disabled and therefore cannot be used by any logical
partition.

The Memory tab shows deconfigured resources, as well as information about available and
configured memory. To view or change memory allocation on systems with huge page table support,
use the Memory tab and select Show details in the Advanced Options area. To change the requested
value for huge page memory, the system must be powered off.

The information provided in the memory tab (for example, deconfigured resources), along with the
information provided on the I/O tab, is useful for planning for processors and dynamic logical
partitions.

3. 

Parent topic: Finding and updating managed systems data on the HMC

Updating managed system or frame information

Update the system information for a managed system or frame in the HMC that is in an Incomplete state.

Updating, or rebuilding a managed system or frame acts much like a refresh of the managed system or frame
information. Rebuilding the managed system or frame is useful when the system's state indicator in the
contents area of the HMC GUI is shown as Incomplete. The Incomplete indicator signifies that the HMC
cannot gather complete logical partition, profile, or resource information from the managed system.

This operation is different from performing a refresh of the local HMC panel. When the managed system is
updated, the HMC reloads information stored on the managed system.

To update managed system or frame information, you must be a member of one of the following roles:

super administrator• 

service representative• 

operator• 

product engineer• 

To update the managed system or frame information, complete the following steps:

In the contents area, select the managed system or frame.1. 
From the menu, click Selected.2. 
Choose from the following options:

To rebuild a managed system, click Rebuild Managed System. The current system
information displays.

♦ 

3. 
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To rebuild a managed frame, click Rebuild Managed Frame. The current system information
displays.

♦ 

Click Yes.4. 

Parent topic: Finding and updating managed systems data on the HMC

Disconnecting another HMC connection

Read about how to manually unlock an HMC locked connection to the managed system.

If you have two HMCs connected to the managed system, one HMC temporarily locks the other out while it is
performing operations. This action prevents the other HMC from operating on the managed system because
simultaneous operations could cause conflicting results. If the interface is locked, most console operations
automatically wait for the lock to release.

However, in the rare event that an HMC has a problem that prevents the lock from being properly released,
you need to manually disconnect the connection to the managed system. Typically, if one HMC has locked
the connection, you must unlock it from the other HMC, which then allows other HMCs to communicate with
the managed system and run further commands.

To release a lock on a managed system requires the super administrator role.

To unlock an HMC connection, complete the following steps:

In the Contents area, select the managed system.1. 
In the menu, click Selected.2. 
Select Disconnect another HMC. The Disconnect Another HMC window opens.3. 
From the list, select the HMC that you want to disconnect, and then click OK.4. 

Parent topic: Finding and updating managed systems data on the HMC

Recovering partition data on a managed system

Learn how to recover the partition data on your managed system if it becomes corrupted.

Through the HMC interface, you can recover partition data on your managed system if the data becomes
damaged. This partition data includes information about logical partitions, partition profiles, and system
profiles. If the partition data on your managed system becomes damaged, the managed system is in recovery
state. You can either restore the partition data from a backup file that is saved automatically on your HMC by
selecting Restore profile data from the HMC backup data, or clear all partition configuration with Initialize the
managed system.

This procedure recovers the partition data in the service processor of your server. To recover the partition
data on your managed system, see Restoring profile data.

Note: The HMC might not show operating state for the managed system after completing this recovery
procedure. After a partition is activated, the managed system will transition to an operating state and clear the
A700 4091 or C700 4091 SRC.

To recover the partition data on your managed system, you must be a member of one of the following roles:
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super administrator• 

operator• 

To recover the partition data on your managed system, do the following:

In the Navigation Area, open Server and Partition.1. 
Select Server Management.2. 
In the contents area, right-click the managed system whose partition data you want to recover and
select Recover Partition Data.

3. 

Select one of the following:
Restore profile data from HMC backup data: This option restores the partition data using the
backup file that is saved automatically on the HMC.

♦ 

Initialize the managed system: This option clears all partition configuration data, and can only
be used if all partitions are in the Not Activated state.

♦ 

4. 

Click OK.5. 

Parent topic: Finding and updating managed systems data on the HMC

Managing frames using the HMC

Learn about the tasks that you can use to manage your frames in the HMC.

This topic describes how to perform various tasks related to managing your frame that is connected to the
HMC.

Adding a frame
Use this procedure to add a frame manually to the HMC.

• 

Initializing a frame
This topic explains how to initialize a frame after a new frame has been added.

• 

Modifying information about a frame
Change a frame's name and number.

• 

Updating frame information
Rebuilding the managed frame information for theHMC. This procedure is helpful when clearing an
Incomplete state.

• 

Resetting or removing a frame connection
This information explains how to reset the HMC connection to a frame, or remove a locked connection
to a managed system.

• 

Parent topic: Working with managed systems and frames

Adding a frame

Use this procedure to add a frame manually to the HMC.

New frames are automatically detected, or discovered, by the HMC when the HMC is configured as a DHCP
server. For information about configuring your HMC as a DHCP server, see The HMC as a DHCP server.
Upon detection of a new frame, the DHCP server assigns an IP address to the frame. This newly assigned IP
address remains static as long as the MAC address remains unchanged. When a frame is replaced, the
DHCP server assigns a new IP address and broadcasts an update to all HMCs on the network.

Note: Add a frame by configuring your HMC to automatically detect new frames. Use the instructions provided
at the link referenced in the preceding paragraph.
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In addition to adding a frame automatically, the HMC allows you to manually add frames to the managed
frames of this HMC. You will need to provide the host name and IP address for each frame that you want to
add. You can also find a frame on the network within a specified IP address range. The discovery processing
time can vary depending on the range of IP addresses that you entered and your network configuration.

To add a frame, you must be a member of one of the following roles:

super administrator• 

operator• 

product engineer• 

To add a frame, complete the following steps:

In the Navigation Area, expand the Server and Partition folder.1. 
Select Frame Management.2. 
Select Add Managed Frame(s). Type the requested information. If you want to find a frame in the
network, select Find managed frames and type the IP address range.

3. 

Click Next.4. 
Click Finish.5. 

Parent topic: Managing frames using the HMC

Initializing a frame

This topic explains how to initialize a frame after a new frame has been added.

After you add a frame in the HMC, it must be initialized before it can be detected by the managed system.
Initialization of the frame consists of powering on all the I/O drawers followed by powering on all the managed
systems that belong to the managed frame. The initialization time might vary depending upon your setup.

To initialize a frame, you must be a member of one of the following roles:

super administrator• 

operator• 

product engineer• 

To initialize a frame, complete the following steps:

In the Navigation Area, expand the Server and Partition folder.1. 
Select Frame Management.2. 
From the menu, click Frame Management.3. 
Select Initialize Frame(s).4. 
Click Continue.5. 

Parent topic: Managing frames using the HMC

Modifying information about a frame

Change a frame's name and number.

You can view frame information and change the frame name and number.

Any user can view or modify frame properties.
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To view and change the frame's properties, complete the following steps:

In the Navigation Area, expand the Server and Partition folder.1. 
Select Frame Management.2. 
In the Contents area, select the frame.3. 
From the menu, click Selected.4. 
Click Properties. You can also access this option by right-clicking the frame and selecting Properties
on the menu.

By default, you are viewing the General tab that includes the frame name, number, state, type and
serial number. To view a list of all the managed systems contained in the frame, use the Managed
Systems tab. The information in the I/O Units tab is helpful when you need to know all the I/O Units
contained in the frame.

5. 

Change the frame name and number, if desired.6. 
Click OK.7. 

Parent topic: Managing frames using the HMC

Updating frame information

Rebuilding the managed frame information for theHMC. This procedure is helpful when clearing an
Incomplete state.

Updating, or rebuilding, the frame acts much like a refresh of the frame information. Rebuilding the frame is
useful when the system's state indicator in the contents area of the HMC GUI is shown as Incomplete. The
Incomplete indicator signifies that the HMC cannot gather complete resource information from the managed
system within the frame.

This operation is different from performing a refresh of the local HMC panel. When the managed system is
updated, the HMC reloads information stored on the managed frame.

To update frame information, you must be a member of one of the following roles:

super administrator• 

operator• 

product engineer• 

To update the frame, complete the following steps:

In the Navigation Area, expand the Server and Partition folder.1. 
Select Frame Management.2. 
In the Contents area, select the frame.3. 
From the menu, click Selected.4. 
Click Rebuild Managed Frame. The current frame information displays.5. 
Click Yes.6. 

Parent topic: Managing frames using the HMC

Resetting or removing a frame connection

This information explains how to reset the HMC connection to a frame, or remove a locked connection to a
managed system.
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When you no longer want to manage a frame using the HMC, you can remove the connection. You must
remove the connection before you physically disconnect the HMC from the managed frame (or from the
network).

In the rare event that the frame is in the No connection state, you can recover by resetting the connection with
the frame. Reset the connection with the managed frame after you have verified that the network settings are
correct on both the HMC and the managed frame. Performing this action will break and reestablish the
connection.

To reset or remove a frame connection, you must be a member of one of the following roles:

super administrator• 

service representative• 

operator• 

To reset or remove a frame connection, complete the following steps:

In the Navigation Area, expand the Server and Partition folder.1. 
Select Frame Management.2. 
In the Contents area, select the managed system.3. 
In the menu, click Selected.4. 
Select Reset or Remove Connection from the menu.5. 
Click Remove Connection or Reset Connection.6. 
Click OK.7. 

After the frame's logical connection is removed, you can remove the HMC from the network.

Parent topic: Managing frames using the HMC

Managing operating systems

Understand how you can use the HMC to interact with the operating systems running on the managed
systems.

You can force some operating systems to shut down or reset using the HMC interface. For more information
about these tasks, review the following topics.

Resetting the operating system on a partition
Restart the operating system when an operating system in a logical partition hangs.

• 

Shutting down an operating system
This information explains how to shut down an operating system in a logical partition.

• 

Parent topic: Working with managed systems and frames

Resetting the operating system on a partition

Restart the operating system when an operating system in a logical partition hangs.

The HMC enables the operating system on a logical partition to be reset when errors are encountered in the
operating system. The system can undergo either a soft or hard reset.

To reset the operating system, you must be a member of one of the following roles:
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super administrator• 

service representative• 

Note: For logical partitions, use this task only if you cannot restart the logical partition from the command line
of the operating system. Using this window to restart an logical partition will result in an abnormal IPL.

To reset the operating system on a logical partition, complete the following steps:

In the Navigation Area, expand Server and Partition.1. 
Click Server Management.2. 
In the Contents area, select the logical partition that is running the operating system that you want to
reset.

3. 

In the menu, click Selected > Restart partition.4. 
Select the type of operating system restart.5. 
Click Yes.6. 

Parent topic: Managing operating systems

Shutting down an operating system

This information explains how to shut down an operating system in a logical partition.

You can use the HMC interface to perform shutdown operations on a logical partition. You can perform this
task only if the operating system that is running on the logical partition supports this function.

Note: If your logical partition is running , shut down the operating system manually through the operating
system, if possible. Using the HMC interface to power off the logical partition operating system will cause
longer restart times. For more information about shutting down an logical partition, see Shutting down .

To shut down an operating system on a logical partition, complete the following steps:

In the Contents area, select the logical partition running the operating system that you want to reset.1. 
In the menu, click Selected > Shut Down Partition.2. 
Select the type of shutdown that you want to perform.3. 
Click OK.4. 

Parent topic: Managing operating systems

Adding managed systems to the HMC environment

Understand how to add managed systems to the HMC, so that you can manage them using the HMC
interface.

You can manage multiple systems from a Hardware Management Console (HMC). To add a managed system
to the HMC, you must establish a network connection between the HMC and the service processor of the new
system. Configuring the HMC to work with the new managed system depends on how you have set up and
configured the existing network connections between the HMC and the already-installed managed systems,
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including connections to the logical partitions.

For more information about configuring network connections on the HMC, see HMC network connections.

Use the following topics to determine how to add a managed system to your HMC environment based on your
existing network configuration. After completing the HMC connection, add the system to your HMC
environment by selecting the managed system connection in the HMC GUI and selecting Add managed
system from the Selected menu. Follow the instructions in the Add managed system window by specifying the
name or IP address of the managed system or specifying a range of IP addresses to find and select the
managed system to add. For more information about the Add managed system function, refer to the HMC GUI
help.

Using an existing private network with the HMC acting as a DHCP server
Use a dedicated private network that you already have set up with the HMC acting as a DHCP server
to manage your system.

• 

Using an existing open network
Understand the requirements for using the HMC in a configured open network.

• 

Parent topic: Working with managed systems and frames

Using an existing private network with the HMC acting as a DHCP
server

Use a dedicated private network that you already have set up with the HMC acting as a DHCP server to
manage your system.

If your existing network is already set up as a "private" dedicated network with the HMC acting as a DHCP
server, then you must physically connect to the new system. For more information about physically connecting
to a new managed system, see Setting up the Hardware Management Console. If you have an Ethernet
switch with available ports connected to the HMC, connect the Ethernet cable from the service processor of
the new system to the Ethernet switch. When the connection is made, the HMC automatically detects the
managed system and adds it to the Contents area of the HMC interface. Automatic detection does not occur if
you removed the managed system prior to its availability.

Parent topic: Adding managed systems to the HMC environment

Using an existing open network

Understand the requirements for using the HMC in a configured open network.

If the HMC was connected to existing managed systems over an "open" (public) network, other types of
devices and systems can exist on the network. More specifically, the HMC is not acting as a DHCP server. In
this environment, you must take one of the following actions to use the HMC:

Manually configure the new managed system's service processor with a static (fixed) set of IP
parameters using the Advanced System Management Interface.

• 

Manually configure the IP address of the new system's service processor, if there is an existing DHCP
server on the network.

• 

When the connection is made, you can add the managed system by using the Add managed systems function
or the mksysconn command.

Parent topic: Adding managed systems to the HMC environment

Deleting a managed system

Disconnect a managed system from the HMC before you physically detach it from the HMC.
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If you no longer want to manage a particular system, you can delete it from the Contents area of the HMC
GUI.

Note: You must delete the managed system from the Contents area before you disconnect the Ethernet or
the network-attached cable from the hardware.

To delete the managed system from the Contents area, you must be a member of the super administrator
role.

To delete the managed system from the Contents area, complete the following steps:

In the Contents area, select the managed system.1. 
From the menu, click Selected.2. 
Select Reset or Remove Connection from the menu.3. 
Click remove, then click OK.4. 

After the managed system's logical connection is removed, you can remove the managed system from the
network.

Parent topic: Working with managed systems and frames

Moving the managed system from an open network to a private
network

Learn how to move a managed system that is attached to an HMC on an open network to an HMC that is
located on a private network.

You can move a managed system from an open network to a private network. It is recommended that you
configure the HMC that is located on the private network as a DHCP server before you attach the new
managed system. This configuration will allow the HMC to automatically detect the newly added managed
system and assign it a unique IP address.

To perform this operation, you must be a member of one of the following roles:

super administrator• 

service representative• 

product engineer• 

To move the managed system from an open network to a private network, complete the following steps:

Configure the HMC that is located on the private network as a DHCP server. For more information,
see Configuring the HMC as a DHCP server.

1. 

Remove the static IP address of the managed system that you want to move using the Advanced
System Management Interface (ASMI). For more information about how to use ASMI to configure the
HMC as a DHCP server, see Configuring network interfaces.

2. 

Disconnect the cable of the managed system that you want to move from the HMC that is located on
the open network.

3. 
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Connect the cable of the managed system to the HMC located on the private network. Because you
previously configured the HMC that is located on the private network as a DHCP server, the newly
attached managed system is automatically detected and assigned a new IP address.

4. 

Parent topic: Working with managed systems and frames

Servicing the managed system

Understand how you can use the HMC to perform service actions.

The Customer service, support, and troubleshooting topic provides an overview of the elements of the service
and support environment. It also describes the different functions and features of the environment and the
HMC applications that provide those functions.

Parent topic: Working with managed systems and frames

Using the Network Manager

Learn how to use the Network Manager to manage InfiniBand (IB) networks.

The Network Manager enables you to manage your InfiniBand (IB) network from the Hardware Management
Console (HMC).

Use the Network Manager to manage IB switches, update switch software, view network topology information,
and view and modify management properties. You must enable the Network Manager from the HMC before
you can use it to manage your network.

For information about setting up the HMC in an InfiniBand (IB) network, see Setting up the HMC.

The following topics describe the tasks that you can perform with the Network Manager:

Enabling and disabling the Network Manager
Enable the Network Manager to manage your InfiniBand (IB) switch network.

• 

Viewing switch topology information in an InfiniBand network
View information about the switch layout and connectivity in your InfiniBand (IB) network.

• 

Viewing server topology information in an InfiniBand network
View information about the physical layout of your InfiniBand (IB) network.

• 

Viewing logical topology information in an InfiniBand network
View information about the logical server layout in your InfiniBand (IB) network.

• 

Viewing Network Manager properties
View and manage switch information and the properties of the currently enabled Network Manager for
your InfiniBand (IB) environment.

• 

Viewing the Network Manager log
View the Network Manager event log.

• 

Updating switch software
Use the Network Manager to update the software for all the switches in your InfiniBand (IB) network.

• 

Parent topic: Managing your server using the Hardware Management Console

Enabling and disabling the Network Manager

Enable the Network Manager to manage your InfiniBand (IB) switch network.

Before you can use the Network Manager to manage your InfiniBand (IB) network switches and systems, you
must enable it from the HMC. When you enable the Network Manager, it starts discovery and begins providing
data about the status of your IB switch network.
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Any user can enable or disable the Network Manager.

Note: If you decide to move the Network Manager functions from one HMC host to another HMC host, you
must first disable the Network Manager on the first HMC host before enabling it on the second host.

To enable or disable the Network Manager, complete the following steps:

In the Navigation area, expand the Switch Management folder.1. 
Click Network Manager.2. 
In the Network Manager menu, select Enable Network Manager Software.

To disable the Network Manager, select Disable Network Manager Software.

3. 

Parent topic: Using the Network Manager

Viewing switch topology information in an InfiniBand network

View information about the switch layout and connectivity in your InfiniBand (IB) network.

You can view information about the switches in your InfiniBand (IB) network that identifies the physical
location and connection activity for all connected switch devices. From within the topology view window, you
can access additional menu options for the objects that you select in the list. For example, when you select a
switch and then click Selected > Properties, you can view system, subnet manager, and backplane details for
that item. For more information about the menu options in the switch topology view, see the online help.

Any user can view the switch topology information.

Note: The Network Manager must be enabled in order for you to access this task in the HMC.

To view the switch topology information, complete the following steps:

In the Navigation area, expand the Switch Management folder.1. 
Click Network Manager.2. 
In the Network Manager menu, select View Switch Topology.

The HMC displays a table with a list of the switches in the IB network. By default, the information
presented shows the switch device name (or identifier), location code, frame information, power on
and off status, GUID, port status, and neighboring port (link) information.

To change the columns displayed in the list of information, click View > Show Columns and select or
clear the check box for the columns that you want to designate as the default columns.

3. 

Parent topic: Using the Network Manager

Viewing server topology information in an InfiniBand network

View information about the physical layout of your InfiniBand (IB) network.
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You can view information about the servers, adapters, and ports in your InfiniBand (IB) network.

Any user can view the server topology information.

Note: The Network Manager must be enabled in order for you to access this procedure.

To view the server topology information, complete the following steps:

In the Navigation area, expand the Switch Management folder.1. 
Click Network Manager.2. 
In the Network Manager menu, select View End-Point Topology.

The HMC displays a table with a list of the servers in the InfiniBand cluster. By default, the information
presented shows the server name, location code, power on/off status, frame/cage information,
adapter status, port status, and neighbor port (link) information.

To change the columns displayed in the list of information, click View > Show Columns and select or
clear the check box for the columns that you want to designate as the default columns.

3. 

Parent topic: Using the Network Manager

Viewing logical topology information in an InfiniBand network

View information about the logical server layout in your InfiniBand (IB) network.

You can view information about the servers, adapters, ports, and related status for the logical partitions in
your InfiniBand (IB) network.

Any user can view the logical topology information.

Note: The Network Manager must be enabled in order for you to access this procedure.

To view the logical topology information, complete the following steps:

In the Navigation area, expand the Switch Management folder.1. 
Click Network Manager.2. 
In the Network Manager menu, select View Logical Topology.

The HMC displays a table with a list of the servers and partitions in the InfiniBand (IB) configuration.
By default, the information presented shows the server name, location code, system or logical
partition status, adapter status, type, the GUID, port status, and neighbor port (link) information.

To change the columns displayed in the list of information, click View > Show Columns and select or
clear the check box for the columns that you want to designate as the default columns.

3. 

Parent topic: Using the Network Manager
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Viewing Network Manager properties

View and manage switch information and the properties of the currently enabled Network Manager for your
InfiniBand (IB) environment.

You can view and modify the Network Manager properties and the switch-management properties for your
InfiniBand (IB) network. For example, use this procedure to change the Network Manager default name
assigned to the managed switches. Using switch names provides a convenient way to keep track of the
switches you are managing (particularly when frame numbers or cage numbers are not readily available). You
can also change the switch-management priority (change the subnet manager master and succession order),
synchronize the switch local time with the HMC time (NTP time is not currently supported), and view the
switch topology.

Any user can view the Network Manager properties.

Note: The Network Manager must be enabled in order for you to access this task from the HMC.

To view the properties, complete the following steps:

In the Navigation area, expand the Switch Management folder.1. 
Click Network Manager.2. 
In the Network Manager menu, select View Management Properties.3. 
Click the Network Manager tab to view the properties.

The HMC displays the HMC host name, the IP address, and version number of the currently enabled
Network Manager.

4. 

Click Switch to view and modify information about the switches in your InfiniBand (IB) environment.5. 

Parent topic: Using the Network Manager

Viewing the Network Manager log

View the Network Manager event log.

The Network Manager maintains an event log that you can view to track the Network Manager activities.

Any user can view the event log.

Note: The Network Manager must be enabled in order for you to access this task in the HMC.

To view the Network Manager event log, complete the following steps:

In the Navigation area, expand the Switch Management folder.1. 
Click Network Manager.2. 
In the Network Manager menu, select View Network Manager Event Log.

The HMC displays the contents of the log file.

3. 
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Parent topic: Using the Network Manager

Updating switch software

Use the Network Manager to update the software for all the switches in your InfiniBand (IB) network.

You can update multiple switches simultaneously for a single software version, or choose a switch and the
version of software to apply for the update of that switch. You can start another switch installation before a
switch update procedure that is currently running has finished; however, if both installations run concurrently
and contain the same switch, the subsequent installation action might fail.

An Import option allows you to add more software versions from a DVD.

Any user can update the switch software.

Note: The Network Manager must be enabled in order for you to access this task from the HMC.

To update your switch software, complete the following steps:

In the Navigation area, expand the Switch Management folder.1. 
Click Network Manager.2. 
In the Network Manager menu, select Update Switch Software.3. 
Select the switches that you want to update.4. 
Select the software version to install for the selected switch or switches.5. 
Click OK to start the software update.6. 

Note: To uninstall the last update, select Return switch to previous software.

Parent topic: Using the Network Manager

Related information

Review technical and "how-to" information.

You can view or download the following ESCALA Power5 Hardware Information topics related to the
Managing your server using the HMC topic:

Managing the Hardware Management Console• 

Managing your server using the Advanced System Management Interface• 

Clustering systems using InfiniBand (IB) hardware• 

Partitioning the server• 

Working with Power On Demand• 

Setting up your server to connect to service and support• 
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Saving PDF files

To save a PDF file on your workstation for viewing or printing:

Right-click the PDF link in your browser.1. 
Click the option that saves the PDF locally.2. 
Navigate to the directory in which you want to save the PDF file.3. 
Click Save.4. 

Downloading Adobe Reader

You need Adobe Reader to view or print these PDFs. You can download a copy from the Adobe Web site
(www.adobe.com/products/acrobat/readstep.html).

Parent topic: Managing your server using the Hardware Management Console
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